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NC1000

NC1000

Specifications
AAttention
o Product specifications may change without prior notice to improve
General Specifications performance.
Dimensions 250 mm (W) x 220 mm (H) x 45 mm (D) (only Set)
Weight 1.321 kg (only Set)
CPU Intel ATOM Processor 330 1.6 GHz(Dual Core), FSB 533 MHz
Chip Set Nvidia MCP7A-I ON
Main Memory DDR3 1066 SODIMM type 1 GB, 2 GB SSD
Secondary Storage Device SATA SSD 8 GB, 16 GB, 32 GB —Ti ngoG_BAAB — 010%% - Nm%%% .
(OJ8) Windows Embedded Standard [ 2GB [NC1000-BABB | NC1000-CABB | NC1000-DABB
Multi 1/0 port
Serial Port One external RS-232 Serial port
USB Port Hi-Speed USB 2.0 port 480 Mbps rate (x5)
LAN Port Realtek RTL8103E 10/100 Mbps Ethernet controller
VGA / HDMI Nvidia MCP7A-ION integrated Graphic chipset
4-in-1 Card Secure Digital (SD) / MultiMedia Card (MMC/MMC4.0) /

Memory Stick (MS/MS-Pro) / xD Memory Card
PCI Express Card Slot Supported
LINE OUT Supported

SPDIF 5.1 Channel Supported (depend on source signal)
(Digital Audio Out)

Operational Specifications

Resolution Maximum Resolution 1920 x 1080 @ 60 Hz
Recommended Resolution 1920 x 1080 @ 60 Hz

Power Rated Voltage AC 100-240 V~, 50 / 60 Hz, 1.2 A

Sound Output Wattage RMS Audio Output 10 W + 10 W (R + L) : When connected to the monitor (model name : M4224C)

Operating Condition Sync (HIV) Video LED
Normal Mode On/On Active On
(E)Se;pzs(';f‘;p Mode OfOft off off

Operating Conditions Operating Conditions Temperature 5Ct35C  Humidity 10 % to 80 %
Storage Conditions Temperature ~ -20 Cto60C  Humidity 5% 1095 %




NC1000

Included in the Box

Basic Components

The NC1000 consists of the following components. Please check that these components have been

included prior to installation.

-

t Handle x 2

M3, L8 x 8
t (for attachment of handle) J

NC1000 tSetup Program/User ManualJ Box Guide J
e N N
£
(-
L Power Cable L RS-232C Cable J Rail x 2
e N A
o
Uk ¥ T
M3, L12x 4

\(for attachment of Box Guide on the monito

)

These illustrations may differ from your product. Some of these are subject to change.

(A Attention
o

Optional items

The following items are supported by the NC1000, but are not provided with the product.
Please purchase optional items as needed.
o HDMI cable, D-SUB cable, LINE-OUT cable, fiber optic cable, LAN cable, mouse, keyboard.

000ION



NC1000

NC1000

Connections

Back Panel

’T"?‘?

RS-232C

DPﬂCAL

LINE-OUT

J.J,JJII )

Number Connection Description

Power Cable In For the power cable.

(B Power Switch Provides power to the NC1000

RS-232C Out For the RS-232C cable.

(D] USB Wireless Modem In For a USB-type wireless modem.

USB In For USB-type devices, including memory, hard disk, CD-ROM, key-
board, and mouse.

HDMI Out For an HDMI-compatible monitor.

LAN Connector Fora LAN cable.
Accommodates memory cards for storing video or reading images.

4 IN 1 Multi-Card Slot Supported cards include Secure Digital (SD), MultiMedia (MMC/
MMC4.0), Memory Stick (MS/MS-Pro), and xD Memory Cards.

[ |} D-SUB Out For the monitor's RGB video in.

OPTICAL Out For an optical cable for digital audio transfer.

NC1000 Power Button Turns NC1000 on.

LINE-OUT Connector For a LINE-OUT cable for analog audio transfer.

PCI MINI EXPRESS Card Slot Provided for PCI Mini Express Cards.




NC1000
Installing

We recommend you to use the items provided with your NC1000 and follow our instructions for integrating
the product with your monitor in order to ensure the correct results.

[A Attention

e The monitor illustrations shown are to guide your integration they may differ from your product.

Place the handle into the slots on the side of the product.

A Warning
(o Be careful of sharp edges on the rail and the handle.

000}+ON



NC1000

NC1000

As shown below, use screws to secure the Box Guide in the four slots at the back of the monitor.




NC1000
In/Out Cable Connection

In order to watch video through a monitor, you need to use a D-SUB cable or HDMI cable to connect NC1000
to a monitor.

—A\ Attention

o D-SUB, HDMI, LINE-OUT, OPTICAL, and LAN cables are not included with the NC1000. If the cables were
not provided with your monitor, you may need to purchase them separately.

o After all required cables are connected, configure SET ID to 1 for the first monitor connected to the
NC1000. The SET ID for one of the connected monitors should be configured to 1.

o To configure the SET ID, please refer to the owner’s manual for your monitor.

o Monitors used with NC1000 should support LG RS-232C protocols. The brightness, resolution, sound, and
other features of an LG RS-232C protocol-enabled monitor can be controlled by SuperSign Manager soft-
ware.

rQ\ Note

o ASET ID is a reference number for the monitor that can be set to the user's preference. The monitor
SET ID is used by the SuperSign Manager software to identify monitors.

Connecting a Monitor with D-SUB Cable

A\ Attention

o A D-SUB cable connection does not include an audio signal. For audio, you need to connect a LINE-OUT
or OPTICAL cable.

i& Note
(c D-SUB cables are also known as RGB cables.

Connect the appropriate power cables to a monitor and NC1000 respectively. (See Turning NC1000 On)

000ION



NC1000

NC1000

In/Out Cable Connection

Connect the D-SUB port of NC1000 and RGB-IN port of the monitor with a D-SUB cable.

~

-

RS-232C
(CONTROL)




NC1000
In/Out Cable Connection

Connect the NC1000 to the monitor with a LINE-OUT cable.

AUDIO

(RGB/DVI)

L
Ecﬁrﬂl LINE-OUT &
\

1

Connect a LAN cable to the NC1000

N\ LanusB /4
~ 7

~ -

000ION
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NC1000

NC1000
In/Out Cable Connection

Connecting a Monitor with an HDMI Cable

HDMI connections allow digital video and audio signals to be transferred with one cable.
HDMI cable connections do not require an additional audio in cable.

r—Q\Note

e In and Out signals are not differentiated when using HDMI cables.

— A\ Attention

o The monitor to connect with NC1000 should have the HDMI in for the HDMI connection.

o To use the HDMI device, you need to activate the HDMI device in Microsoft Windows Embedded Standard, the
operating system of the NC1000. The procedures for activating and deactivating HDMI devices are described below.

Connect the appropriate power cables to a monitor and NC1000 respectively. (See Turning NC1000 On)

il »

HDMI / DVI




NC1000
In/Out Cable Connection

Connect NC1000 (OUT) to the monitor (IN) with an RS-232C cable.

RS-232C

(CONTROL)

{:—@ ERs-mzc éi_l -

~ -

Connect a LAN cable to NC1000.

N\ LANUSB 4
N 7

~ o -

000}ION
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NC1000

NC1000

Connecting/Disconnecting HDMI in Windows

Connecting HDMI
Move to the desktop of the monitor connected to the NC1000.
Click the button in the lower left of the screen.

Select Start > Control Panel > Sounds and Audio Devices > Audio.

Select Play Sounds > NVIDIA High Definition Audio from the list and click OK.

Disconnecting HDMI
Move to the desktop of the monitor connected to the NC1000.

Click the button in the lower left of the screen.
Select Start > Control Panel > Sounds and Audio Devices > Audio.
Select Play Sounds > Realtek HD Audio output from the list and click OK.

A\ Attention

o If you do not reset after disconnecting the HDMI cable from the NC1000, the sound will not work.
o In order for the sound to work properly, stop playing the content and restart the NC1000.




NC1000

NC1000 Installation Confirmation

Connect the NC1000 to the monitor as described
on the previous pages and turn the monitor and the
NC1000 on. When the monitor is on, the SuperSign
Player home screen will appear as shown here.

Elite -s
SuUPERSIGN

™

C
-

Connection to Multiple Monitors

Each NC1000 can accommodate up to 25 monitors for video playback.
You can connect it to several monitors in Tile Mode.

Connect the NC1000's D-SUB OUT to the D-SUB IN of the first monitor, which has SET ID = 1
Connect other monitors with D-SUB cables as shown below (IN/OUT separated).

NC1000 T RGB Cable

Monitor

Connect the NC1000's RS-232C OUT to the RS-232C IN of the first monitor, which has SET ID = 1.
Connect other monitors with RS-232C cables as shown below (IN/OUT separated).

NC1000 -

RS-232C Cable

(max 25)

Monitor

A\ Attention 24 Note

e You may want to purchase additional RS-232C o To play video in Tile Mode, go to Creating Tile
cables to use several monitors together. Mode > Create Tile in this manual.

e You cannot use multiple monitors with the HDMI
cable.

000ION
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NC2000

NC2000

Specifications

General Specifications

AAttention

e Product specifications may change without prior notice to improve
performance.

Dimensions 99.8 mm (W) x 183.3 mm (H) x 28.4 mm (D) (only Set)

Weight 0.215 kg (only Set)

CPU Intel ATOM Processor 330 1.6 GHz(Dual Core), FSB 533 MHz

Chip Set Nvidia MCP7A-1 ON

Main Memory DDR3 1066 SODIMM type 1 GB, 2 GB

g‘;ﬁf’cneda'y Storage SATASSD 8 GB, 16 GB, 32 GB e =0 G

. DDR| 1GB | NC2000-BAAB | NC2000-CAAB | NC2000-DAAB

(018 Windows Embedded Standard | 2GB | NC2000-BABB | NC2000-CABB | NC2000-DABB

Multi I/O port

Serial Port N/A

USB Port Hi-Speed USB 2.0 port 480 Mbps rate (x3)

LAN Port Realtek RTL8103E 10/100 Mbps Ethernet controller

VGA/HDMI Nvidia MCP7A-ION integrated Graphic chipset

4-in-1 Card N/A

PCI Express Card Slot Supported

LINE OUT N/A

SPDIF N/A

(Digital Audio Out)

Operational Specifications

Resolution Maximum Resolution 1920 x 1080 @ 60 Hz
Recommended Resolution 1920 x 1080 @ 60 Hz

Power Rated Voltage DC12V/35A

Sound Output Wattage N/A

Operating Condition Sync (HIV) Video LED
Normal Mode On/On Active On
(Dse;;ls;gp Mode OfIOff off off

Operating Conditions Operating Conditions Temperature 5Ct35C  Humidity 10 % to 80 %
Storage Conditions Temperature ~ -20 Cto60 C  Humidity 5% t0 95 %




NC2000
Included in the Box

Basic Components

The NC2000 consists of the following components. Please check that these components have been

included prior to installation.

(A Attention
o

NC2000

o/

Setup Program/User Manual
& )

[

SCrew x 2

These illustrations may differ from your product. Some of these are subject to change.

000¢ON
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18

NC2000

Connections
Back Panel
Number Connection Description
HDMI Out For an HDMI-compatible monitor.
B LAN Connector For a LAN cable.
USB In For USB-type devices, including memory, hard disk, CD-ROM, key-
board, and mouse.
D] PCI MINI EXPRESS Card Slot Provided for PCI Mini Express Cards.




NC2000
Installing

We recommend you to use the items provided with your NC2000 and follow our instructions for integrating
the product with your monitor in order to ensure the correct results.

( A\ Attention

o The monitor illustrations shown are to guide your integration they may differ from your product.

Remove the screw and Metal cover.

'\§ Note

o If card does not become fully inserted into the insertion direction.
Hit by hand carefully to make fully connected.

Use screws to secure the player and the Box Guide as shown below.

000¢ON
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SuperSign Solution
What is SuperSign?

SuperSign is a digital signage solution developed exclusively by LG Electronics. The comprehensive LG
SuperSign solution offers displays, media player (hardware and software), and management programs.

Component LG

Display

Media Player LG SuperSign Solution
D. Elite-s .
Software SUPERSIGN
UD Digital Signage Solutions
'\§ Note

o Digital Signage Solution is a network-based digital signage communication program. These new advertising
media can be used in various places such as commercial and public facilities, airports, and schools,
depending on the ad content and location’s conditions.

Display

A monitor (or monitors) is connected to the media player and used to display advertising content. LG’s SuperSign
Solution supports most LCD monitors supporting LG RS-232C protocols. The brightness, resolution, sound, and
other features of an LG RS-232C protocols-enabled monitor can be controlled by SuperSign Manager software.

'\§ Note

o Display types and their controllable range are listed in the Appendix of this manual.

Media Player

SuperSign Solution's Media Player includes the NC1000/NC2000 hardware as well as its software.

Software

The SuperSign Solution provides SuperSign Manager software, an all-in-one management program that is
used to control the display and the media player, as well as the means to create and distribute media.

Q\ Note

o More information on SuperSign Manager is available in the SuperSign Manager section of this manual.
e The contents of SuperSign software are copyrighted by LG Electronic, Inc. and they may not be edited,
reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying,
recording, downloading, digital transmission, imaging, or any other information storage and retrieval
20 system, without the prior written permission of LG Electronic, Inc.




SuperSign Solution
How to Install SuperSign Solution

Via LAN/Internet Network

NC1000/NC2000-integrated monitors can be connected via LAN or the Internet.

Monitor

Supersign Manager

(o With SuperSign Player, each display can play different content at the same time.

Via RS-232C Cable(NC1000 Only)

One NC1000-integrated monitor (with SET ID = 1) can accommodate multiple monitors.

'\§ Note

o Because only one SuperSign Player is attached, the connected monitors can play the same video only.
o NC2000 does not support RS-232C connection.
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SuperSign Player
What is SuperSign Player?

SuperSign Player is the software portion of NC1000/NC2000, the LG Digital Signage Media Player, designed to
play digital signage content. SuperSign Player can play media files such as video, images, audio, Flash files,
and documents transferred from the SuperSign Manager.

A\ Attention 24 Note
o The SuperSign Player is pre-installed on the o The media file types that can be played by SuperSign
NC1000/NC2000. Start the NC1000 and check that Player are listed in Files Supported by SuperSign
SuperSign Player is installed. section of the appendix.
A Attention

Start SuperSIQn Player e Power is automatically supplied to

. NC2000 when the monitor is turned on.
Turning NC1000 On

When you are finished connecting the cables, turn NC1000 on by pushing the power switch at the back panel.

Qi\ Note
(- For details on the NC1000's back panel, go to Name and Functions of Each Part.

Turn NC1000 on in the following order:

Check that the power cable is properly inserted into the NC1000 power in.
Flip the power switch to supply power to the NC1000.
Push the NC1000's power button. The green lights will come on to indicate that the power is on.

After the NC1000 is turned on, SuperSign Player automatically runs
and its home screen appears.

[ Elite -s

TILi SuUPERSIGN™

A\ Attention 24 Note
o If the home screen is not displayed, check whether the | | @ Press the ESC key on the SuperSign Player home
monitor is on. screen to display the desktop.

o |f the monitor power is on, check that NC1000 is
connected to the monitor with the correct cables.




Type in your password and click OK to view <SuperSign Player Menu> as shown below.

I

SuperSign Player

SuperSign Player Settings

The SuperSign Player can be customized for multiple users.

Log-in to the Setting Menu

To use SuperSign Player setting menu, right click on the SuperSign Player ( I%) icon located on the
Windows taskbar. Its pop-up menu will appear as shown below.

Open exported file
Play schedule
Delete schedule

Setwp

About the program
Close

Click Setup to display the password entry screen.
The SuperSign Player's default password is set to "0000".

- ]

perSlgn Player menu

Su
NIC setting
Player IP setting

Screen setting

Password

MOOO =)

Server IP setting

Initialize S/W

» Agere Systems ET-1...
» Dynamic IP

» Auto setting

iﬁ; Note

You can change the password by yourself. For details on password setting, refer to the Password section of this manual.

23
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SuperSign Player

Network Settings

You can set the player IP (the IP of the NC1000/NC2000 in which SuperSign Player software is installed) and the
server IP (the IP of the PC on which SuperSign Manager software is installed) in Network Settings.

NIC Setting
With NIC Setting option, you can select a network interface card from the list. This option is used when there are
more than one network card installed on your player.

o,
Network Player IP setting Agere Systems E... & NOte

Server IP setting

Screen setting Rlzdeny

o The SuperSign Player will automatically detect a
network interface card available when the player is
started.

o

F

-

Initiali

Player IP Setting
The Player IP setting is for the NC1000/NC2000 IP settings. It is set to Dynamic IP by default.

o With Dynamic IP enabled, the IP will be automatically

NG settng ) generated.
Dynamic IP
o With Static IP option, you can assign a specific IP for
Server IP settin,
. :‘ ! NC1000/NC2000 by yourself.
Screen setting | 72" StnG
a o The Player name is set to the MAC address of the
P NC1000/NC2000 network device by default. The user can
@ change it later.
o Click Save to save settings.
|ni:isg




SuperSign Player

Server IP setting

In the Server IP settings, you can set the IP of the PC (server) on which SuperSign Manager is installed.

It is set to Auto Setting

by default.

S

Network: Player IP setting

uperSign Player menu

@ NIC setting

e

Auto setting

E | Server IP setting

Manual setting

Screen setting | /7rd setting

I

Initialize S/W

'\§ Note

o With Auto Setting selected, the IP of the server using the
same network as the player will be automatically assigned.

o With Manual Setting selected, you can choose a specific
server IP.

o Click Save to save the settings.

e Only IPv4 is supported in the player and the server IP settings.
o If you entered the IP manually, and the network is disconnected, check the IP address and try again.

Wizard Setting

The SuperSign solution now provides SuperSign Wizard setting that guides you through the necessary steps to
configure the network settings on your SuperSign Player and SuperSign Manager.

A Attention

o Before continuing with the Wizard setting, please make sure that you already have a SuperSign Manager
installed on your server. If not, the wizard may not setup network connections correctly.

25
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SuperSign Player

Follow the steps below to setup network connections by using the Wizard.

Select the network environment that you want to use to connect to SuperSign Manager and SuperSign
Player.

SuperSign Network Setup Wizard x|

0> 0 0 0 0

Welcome to the SuperSign Network Setup Wizard

Before continuing, you must install
the SuperSign Manager program on your computer.

o Choose the LAN when the SuperSign Manger and the
SuperSign player are connected to the same network.

e Choose the WAN when the SuperSign Manger and the
SuperSign player are connected to the different networks.

[ Local Area Network (LAN) LI Wide Area Network (WAN)

When the server and all Players are When the server and all Players are
on the same network. not on the same network.

z—Q?; Note

o If the default gateway address and the subnet mask set to the SuperSign Manager are same as the
SuperSign Player, they are connected to the same network.

e Here is how to find the default gateway address and subnet mask set to your SuperSign Manager.
Go to the desktop of the server on which the SuperSign Manager is installed.

1. Click Start > Control Panel.

2. On the control panel, double-click Network Connections.

3. Right-click Local Area Connection.

4. Click Properties.

5. Select Internet Protocol (TCP/IP), and then click Properties.

6. The Internet Protocol (TCP/IP) Registration Information dialog box appears.
7. Check the default gateway address and the subnet mask.

e For SuperSign Player network settings, see SuperSign Player Settings > Network Settings in this
manual.




SuperSign Player

SuperSign Netwark Setup Wizard

© >0 0 60

Set Player name

Player name:

ISuperSign

A Player name can contain letters, numbers, and special characters.

SuperSign Netwark Setup Wizard

© 0 ©> 06

Select network connection

Select a network interface card for network connection below.

Agere Systems ET-131x PCI-E Gigabit Ethernet Controller v

SuperSign Netwark Setup Wizard

©° @ ©>0° 60

Set Player IP address

Player's IP address can be assigned automatically or manually.

e

123.456.78.9 '

1 Dynamic IP L Static IP
The Player IP address Assign the Player IP address
will be assigned automaticaly. yourself,

{ Previous.

Enter a name for SuperSign Player. The SuperSign Man-
VAN ager will use these names to identify the connected play-
ers.

Select a network interface card that will be used for
network connections.

Set SuperSign Player IP address. The Player's IP address
can be assigned automatically or manually.

e Choose the Dynamic IP when you want the Wizard to
automatically set the IP settings.

e Choose Static IP when you want to assign the IP address
yourself.

21
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SuperSign Player

SuperSign Network Setup Wizard

© 0 © 060

Set server IP address
Server's IP address can be assigned automatically or manually.

g

LJ Manual setting

The server IP address Assign the server IP address
will be assigned automatically. yourself,

Set the IP address for the server on which SuperSign
S8 Manager is installed. The server's IP address can be as-
signed automatically or manually.

o Choose the Auto Setting when you want the Wizard to
automatically assign the IP address to the server.

o Choose the Manual Setting when you want to assign the
IP address yourself.

{ Previous

SuperSign Network Setup Wizard

© 0 © 06 6

x

Connecting...

To complete the network connection,
move to SuperSign Manager and select "File Menu ) Option ) Start
search”,
Please check the connection to players by running "Start search”.

A connection will be made if the player is connected
with a network cable properly. To complete the network
connection, move to SuperSign Manager and select Op-
tion > Start search in the File menu. Please check the
connection to players by running "Start search".

A\ Attention

o If you receive an error message, make sure that the server and player are connected to the network and

try again.




SuperSign Player

Screen Setting

In the Screen Setting menu, you can choose the screen view type. The type is set to Landscape by default.

Landscape

o Select Landscape when you position the monitor horizontally.

o Select Portrait when you position the monitor vertically.

29



SuperSign Player

Password

In Password menu, you can set a password to access the SuperSign Player Menus.

Settings

You can choose whether you want to use a password when entering the SuperSign Player Menu.

R
SuperSign Player Menu

Network | Change Rl o If you select Enable, you must type in your password
m to use the SuperSign Player Menu.

o If you select Disable, you can use the SuperSign

Screen Setting

Password Player Menu without entering your password.

EWF

Initialize S/W

Change
You can change the password required for the SuperSign Player Menu. The password should be a four-digit

number. You will then have to use your new password to launch the SuperSign Player Menu.

G 8|
S
SuperSign Player Menu Enter a new password in Change menu and click the
@ Setting 1 OK button.
Network | Change Chanos The Verify menu will be activated..
- = In the Verify menu, re-enter the same password you
Screen Setting Verify . .
(L] ox 788 used in the Change menu. Save the change by click-
Password mg the OK.
@ 5 This will display the message:
EF "Your password has been changed."
Initialize S/W.




SuperSign Player

EWF

In the EWF menu, you can select whether you want to use the Enhanced Write Filter feature of Microsoft
Windows Embedded Standard.

e
SuperSign Player Menu

o EWF protects against viruses that can destroy the

product file system.

Setting
N@m | e o With EWF enabled, you cannot add, delete, or modify
m data saved on the C drive of the NC1000/NC2000.
ScreenSetting e When you need to add a new program to the NC1000/

NC2000, disable EWF.

o With Enable selected, the new program cannot be

Password

EWF installed.
= o To apply the change to EWF, restart your system.
Initialize S/W.
— '\& Note

o For more information on EWF, visit the Microsoft website.

o Settings of the <SuperSign Player Menu> such as network and screen settings and the EWF password
are not deleted, because they are not controlled by EWF functions.

o |t takes about five seconds to two minutes for the IP and EWF setting changes to be applied.

ﬁA Attention

o When EWF was enabled, the data will be deleted if you reboot the machine even though you saved data in
the C drive. If you want to keep the data, save it in the D drive.
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Initialize S/W

The Initialize S/W menu allows you to initialize the SuperSign Player settings.

When you click Yes, the SuperSign Player settings will return to the same conditions that existed at the time of
your purchase.

(A Attention

o Even after you initialize the software, the network settings will not be reset.
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Language Options and Regional Settings

Language Options and Regional Settings

If you want to change the language, you can use Regional and Language Options of Microsoft Windows
Embedded Standard, the NC1000/NC2000's operating system.

To Change the Language:

Disable EWF in SuperSign Player Menu.

VAN In Windows, select Start > Setting > Control Panel > Regional and Language Options.
Choose the language you want to use as shown in the illustration.
Re-install SuperSign Player with the new language.

Enable EWF in SuperSign Player Menu.
n Reboot the system.

Regional and Language Options

| Regional Options | Languages | Advanced
Language for non-Unicode programs

This system setting enables non-Unicode programs to display menus
and dialogs in their native language. It does not affect Unicode
programs, but it does apply to all users of this computer.

Select a language to match the language version of the non-Unicode
programs you want to use:

Endich (United States) [¥]

Code page conversion tables

M (]
[C] 10001 (MAC - Japanese] o)
10002 (MAC - Traditional Chinese Big5)

10003 (MAC - Korean)

[] 10004 (MAC - Arabic)

[] 10005 (MAC - Hebrew) [a]

Default user account settings

[C] Apply all settings to the current user account and to the default
user profile

Lok ][ cancel | [_aeeb ]

o SuperSign Manager and SuperSign Player should use the same language.

(A Attention
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SuperSign Player Functions

Signage Mode (Video Playback Mode)

Set up the SuperSign Player runs automatically. Then SuperSign Player automatically executes the Play
Schedule feature. Signage mode is for playing pre-distributed videos based on the assigned schedule.

The Signage mode screen is shown below.

Elite-s
™

SUPERSI

— %4 Note

o When SuperSign Player is restarted, ad content is automatically played according to the last transferred
schedule. However, content distributed from the Edit Contents or Management menu of SuperSign Manager
will not play automatically even if SuperSign Player is restarted. See SuperSign Manager Schedule for details.

,—A Attention

e The Playback may be slow when more than two full HD videos (H.264, MPEG-2, WMV) or other types of
media are played simultaneously.

e When text is overlapped with more than two videos, this may cause blinking.

e The PowerDVD SE is included in SuperSign Player. If you remove the PowerDVD from SuperSign Player,
quick video play will not be available.

o If you use Transition effects onto full-HD pictures or more than two pictures, playback may become slow.

e A change to the Windows Standard Timeline will be applied after SuperSign Player is restarted.
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Tray Icon Description

If you click the ESC key in signage mode while videos are playing, the video will pause and move to the desktop.

The SuperSign Player tray icon shows the server connectivity status as shown below.

SuperSign Player Tray Icon Description

SuperSign Player is being installed.

(

SuperSign Player is being uninstalled.

N,

LY

SuperSign Player is connected to the server in which SuperSign
Manager is installed.

SuperSign Player is not connected to the server in which SuperSign
Manager is installed.

& &
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Tray Icon Menu

Right-click the SuperSign Player tray icon in the lower right of the desktop to display the tray menu.

== e
Open exported file
Play schedule

Delete schedule

Setup

About the program
Close

Menu Description
Open This shows the content list transferred by SuperSign
Exported Manager. You can select the content you want to play
File from the folder in which it was saved.

Play schedule

You can play the content based on the SuperSign
Player's schedule.

Delete Schedule

Delete the schedule stored on the SuperSign Player.

Setting Go to the SuperSign Player Menu.
About the The program information including SuperSign Player
Program software version is shown here.
Exit Exit SuperSign Player.

Viewing SuperSign Player Summary Information

When you move mouse over the SuperSign Player tray icon, the program summary information will be

shown for about five seconds.

SupetSign 1.0.0

- Connected to 192.168.0.10

- Ready,

AECS

Information Type

Message

Description

Software Information

SuperSign 1.0.1.1

The SuperSign Player version.

Disconnected from SuperSign Manager.

Server Connection Disconnected Connected to SuperSign Manager
Information ; i
P Address The IP address of the connected/disconnected SuperSign
Manager
Ready There is no schedule registered.
Schedule Information
Scheduled There are one or more schedules registered.
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What is SuperSign Manager ?

Product Information

SuperSign Manager is a network-based comprehensive management program that creates and manages digital
media, distributes content, and supports video playback and remote control.

Contents Edit

You can create content for the SuperSign Player with a variety of media files. It supports numerous media
files, including video, audio, documents, and Flash files, and applies an easy drag and drop feature to
facilitate content creation.

Schedule Management
You can manage the schedules of your content to be played in the SuperSign Player. Schedules can be
assigned by period as well as time.

SuperSign Player Management
You can register and manage more than one SuperSign Player on the same network. You can manage the
registered SuperSign Players by controlling their power on/off, multiple monitor connection, and updates.

37
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How to Install SuperSign Manager

The SuperSign Manager is supplied with the NC1000/NC2000. Insert the CD included with the NC1000/NC2000
into your PC and install SuperSign Manager.

System Requirements

SuperSign Manager PC Recommended Specifications

Accessories Requirements
CPU 2.5 GHz Core 2 Duo L2 Cache 2 MB or higher
RAM 2 GB or higher
HDD 250 GB or higher
Network 100 Mbps or higher
(O] Windows XP sp3 or Window 2003 Server
Graphics Card Memory 512 MB or higher

SuperSign Manager PC Minimum Requirements

Accessories Requirements

CPU 2.0 GHz L2 Cache 512 KB or higher
RAM 1 GB or higher

HDD 40 GB or higher

Network 10 Mbps or higher
(OS] Windows XP sp2 or higher
Graphics Card Memory 512 MB or higher

'\§ Note

o SuperSign Manager supports Windows XP (32-bit), Windows 2003 Server (32-bit), and Windows VISTA
(32-bit) only. The program cannot be run on operating systems other than those listed above.
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Installing the Program

When the CD provided with the NC1000/NC2000 is inserted into a PC, the installation program will run
automatically as shown below.

SuperSign

SuperSign Program Installation

£ Close

SuperSign Program
A persig )

Installation Installation is initiated by clicking SuperSign Manager.

'\§ Note

o If the installation program does not run automatically, open the window manually by double clicking the
file SupersignMgr_setup.exe in the CD-ROM drive: WSuperSign#SuperSign_
SoftwareWApplication¥*SuperSign_Manager#directory of the CD.
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Installing SuperSign Manager

When the CD provided with the set is inserted into a PC, the installation program will run automatically.
Follow the steps below to install the SuperSign Manager.

File Download - Security Warning,

Do you want to run or save this file?
D Name: SuperSignigr_setup.exe

Type: Applcation
From: E:#CD manualWsuperSignWSuperSign_Software. .

W
L

i If . do not
1un o save this software. What's the risk?

Internet Explorer - Security Warning

publi
software?

Name; SuperScnitr_setupexe
Publisher: Unknown Publisher

You
How can ] decide what
software to run?

Installer Language

% Supersien Manager Setup - OX

to the SuperSig ge
Setup Wizard

This wizard wil quide you through the installation of
‘Supersign Manager.

It is recommended that you close all ther applications

relevant system files without having to reboot your
‘computer.

Click Next to continue.

Click Run in the Download file pop-up window.

Click Run in the Security Warning pop-up window.

Select the language and then click OK to continue.

After reviewing the installation instruction, click Next to
continue.
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e SR

Choose Install Location
c R
all | chek.
folder, Click

Space required: 100.1M8
Space available: 679.6M8.

¥ Supersign Manager Setup - X
Installing
Please wait while SuperSign Manager is being installed. E

Extract: media.exe... 57%

== Adobe AR Setup
Adobe” AIR?

Installer Setup

IAgree Cancel

= Adobe AIR Setup.
Adobe® AIR®
d Installation completed.

Finish

If necessary, change the installation path to the direc-
M tory where you want to install SuperSign Manager.
Click Next to continue.

Installation is initiated. Click Details to see the detailed
installation process information during installation.

During the installation process, Adobe AIR installer will
I8 run toinstall it. Click Agree to install Adobe AIR. You must
install Adobe AIR to use SuperSign Manager properly.

n Click Complete to finish the installation of Adobe AIR.

4
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Install Adobe Flash Player

n Adobe Flash Player Active X installation is initiated.

INSTALL

Install Adobe Flash Player

I

Click DONE when the installation of Adobe Flash Player
Active X ends.

. supersign Manager Setup e

Completing the SuperSig 9
Setup Wizard
‘SuperSign Manager has been installed on your computer.
Click Finish to close this wizard.
" After SuperSign Manager installation is complete, click
Finish to exit the installation.
[JAddto quicklaunch|
[CJAdd to desktop

1&; Note

o When you re-install the program without uninstalling it, you can preserve the data or initialize the system.
o |f you use Windows Vista, you should log on as an administrator. Otherwise, you cannot install the
42 program.
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Uninstalling the program

To uninstall SuperSign Manager, Click Start > Program > SuperSign Manager > Remove SuperSign Manager.

@ Accessories
@ Startup
@ Intemet Explorer

() Outlook Express

(®) Windows Media Player
) Windows Movie Maker
M@ SuperSign Manager

Administrator

All Programs D

(] Loa Off

% stant

» % Remove SuperSign Manager

@ ﬂ ‘SuperSign Manager

Follow these steps to uninstall SuperSign Manager.

%' supersign Manager Uninstall

Uninstall SuperSign Manager 5
e i e it =}
=
uninstallation.
C:¥WProor

¥ supersign Manager Uninstall

Uninstalling

Click Remove to start the un-installation of SuperSign
Manager.

Click Details to see the detailed un-installation process
information during un-installation.
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Completing the Sup

Uninstall Wizard

‘SuperSign Manager has been uninstalled from your

b

Rkt core e, 3 After SuperSign Manager uninstallation is complete,
Click Finish to exit the un-installation.

,—QgNote

o SuperSign Manager can be uninstalled by using Add or Remove Programs in Control Panel.

1. Windows XP, Windows 2003 Server
Select SuperSign Manager in Start > Settings > Control Panel > Add or Remove Programs, click
Remove.

2. Windows VISTA
Select SuperSign Manager in Start > Settings > Control Panel > Programs and Features > Uninstall or
change a program, click Remove.

f—A Attention

o All data created by the user will be deleted when the program is uninstalled.
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Starting SuperSign Manager

Starting SuperSign Manager

Open the program by clicking Start > Programs > SuperSign Manager > SuperSign Manager.

) Accessories
@) Startup
@ Internet Explorer

(%) Outlook Express

() Windows Media Player
) Windows Movie Maker
AllPrograms > el (% Remove Supersign Manager

r 5
W) . o @ " SuperSign Manager

Administrator

Logging In
Log In x|
Y ——— ’ When SuperSign Manager starts, a log-in window appears
as shown below.

and password to log in to
SuperSign.

UserID  Administrator

If you are running SuperSign Manager for the first time,
you should create an ID and password you want to

Password : Al use. Log in to SuperSign Manager by clicking the OK
button. When you click the Cancel button, your login will
oK Cancel be canceled, closing the program.

— % Note
o When SuperSign Manager is initially run, the default user ID is set as "Administrator”, which you can
change later.

r—A Attention
o You must remember the new ID and password you set because they will be needed for the next login.
o If you lose your password, it cannot be restored. You will need to initialize the administrator account.
o To do this, enter "1234567890init" in the password field.

e Your ID and password can be up to 20 characters each.
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Selecting Players

When you are signed in, SuperSign Manager
I automatically searches for SuperSign Players on the
same network.

9 When scanning is finished, the available SuperSign
Players are listed.

Select the SuperSign Player to which you want to
KM connect and then click OK or the Canvas Setting
button.

Select a player %

£ New Group

e Scan
Repeat the search for connected SuperSign Players.

o Canvas Setting
R = You can set the desired resolution.

Ok Cancel o OK
The OK button brings up a window from which you can choose
templates and layouts.

Canvas seting

o Cancel
Cancel the selected SuperSign Player.

o Do not display on the next startup.
The Select a Player window will not appear again.

i& Note
‘ﬁ. Time for searching players may vary depending on the number of players.
46
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Setting Canvas

The canvas is a space where you can import and edit photos, videos, and text.

Click Canvas Setting in the Select a player window to display it.

Canvas setting x

Ok Cancel

You can select the resolution you want in the Canvas Setting window. Choose the resolution and click
the OK button.

Q Note

o If you click the OK button on the Select a Player screen, the Canvas Setting is skipped and you go directly
to the Select Template or Layout screen.

o SuperSign basically supports 1920 x 1080, 1360 x 768, 1080 x 1920, and 768 x 1360 monitor resolutions.
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Selecting Templates or Layouts

SuperSign Manager provides popular layouts or templates to help users create content easily and quickly.

When you click the OK button on the Select a Player window or the Canvas Setting window, the Select
Template or Layout screen will appear.

Select Template or Layout x

[ 00:11:0F:00:08:68 1360x768

HOOE

CaACAraci

Bars/Restaurants

Shopping

Educational/Public Organizations
Finance

User template

oK Cancel

Select a template or layout and then click the OK button.

'\§ Note

o SuperSign provides templates and layouts if the resolution is 1920 x 1080, 1360 x 768, 1080 x 1920, or
768 x 1360.
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SuperSign Manager Overview

Index Item Description
File Menu The major features of SuperSign Manager are listed here.
(B) Tob Menu With tab menus, content editing, content play schedule setting, system
P management are done here.
Content editing, playback schedule setting, and player management are done
Workspace "
D] Hide Button  If you click the Hide button, the window not in use will be displayed or hidden.

49
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Contents Edit

SuperSign Manager provides a media content editor.

You can create content and play it in SuperSign Player with this content editor.

Overview

Content editing and various other features are available under Contents Edit in the top menu.

o Shedie > B8, Menspoment

—)
—9
—&
—a
e —3)
Index Item Description
File Menu  The major features of SuperSign Manager are listed here.
(B] Too Menu With tab menus, content editing, content play schedule setting, system management
P are done here.
Media You can view items registered in the templates and the media library. The SuperSign
Window Player's registered information is available here.
Quick I, )
(D] Menu Popular content editing features are displayed for easy access.
An intuitive timeline is provided to allow for time editing and arrangement by zone.
Timeline The timeline allows you to specify the duration for each content clip so that your media
will play at the designated time. Start time, duration and end time of the zone can be set.
The canvas is a space where you can import and edit photos, videos, and text.
You can divide the canvas zone and apply a different layout in each section. By
Canvas : . . L S e
overlapping many images in the divided sections in different timelines, you can
create multiple image layers.
Tool Win-  You can change the properties of the selected zone or media. Use this to change
dow background color or image properties.
Properties Displays the properties of the selected zone or media. Information about the connected

SuperSign Player and the resolution of the zone is displayed.
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Checking details

Saromee ] woowo olgy

Index Description

Canvas file name and resolution.

(B Buttons for creating zones and text boxes.

" Create a zone on the canvas. Click the Zone button and then click on the
Zone

' canvas to create a zone.

M Toxt Create a text box on the canvas. Click the Text button and then click on the

' -~ canvas to create a text box.

The scroll bar used to zoom in or out on the canvas screen.
The screen size is controlled by moving the bar or entering a number in the field.
The unit for the screen size adjustment is 10.

«—Q;Note

o What is a Zone?
A SuperSign Manager Zone is an area on the canvas in which media or a layer is placed while the content is
being edited. You can create a zone by combining different types of media items and creating an ad by
including another zone or zones (a zone can accommodate only one type of media). The zone can include
photos, documents, web pages, videos, Flash files, music, and more. Because each zone is a separate area,
it has its own properties and can be easily deleted or inserted. Also, ad content is easily created by dragging
and dropping onto the canvas.
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Index Description
D] Quick menus that allows using popular content-editing features.
You can preview your content before playing it with SuperSign Player.
. A Preview | This allows users to preview the content being edited within the canvas
prior to exporting it to SuperSign Player.
——— | You can transfer your content to SuperSign Player that is on the same
> Send to player .
network as SuperSign Manager.
| x Stop the player Stop playing the content currently playing on the player.
rA Attention

o Make sure that the MS Office programs are closed before previewing MS Office files.
o Office or web files may not be displayed in the edited order (Z-order).
o To loop Flash files, set them to play repeatedly.

’—Q?;Note

o Content file names can include letters, numbers, and special characters such as @, #, $, %, [, ], {and }.
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Changing Layouts
You can change layouts to suit your needs.

Click Template > Layout in the left part of the SuperSign Manager screen.
This will display the layouts registered in the media library.

Double-click on a new layout.
It will be shown on the canvas.

o If you change the layout, the content you are editing will be lost. Save it before changing the layout.

(A Attention
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Changing Templates
As with layouts, you can change templates to suit your needs.
Click on Template in the left part of the SuperSign Manager screen.

This will display the templates registered in the media library under different categories. The categories
include bar/restaurant, shopping, and public organizations.

Double-click on a new template. This example explains how to change an existing template to a
shopping mall template. (double-click the shopping.)

The selected template will appear on the canvas.

A Attention
54 (- If you change the template, the content you are editing will be lost. Save it before changing the template.
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Using Library

The media library is used to enroll media files needed for media content production, and to use services,
including websites, RSS, and Widget. To register media files in the media library, click the Library tab on the
media window in the left part of the SuperSign Manager screen.

'\&; Note

o A video thumbnail is picked randomly from the middle frames of the file.

o If a video cannot be uploaded, check the required codecs from the Codec Package Installation in the
appendix.
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The library is divided into media and service as shown below.

Add a Media File
You can add photos, videos, Flash files, music, PDF, and MS Office files on the media tab.

] Media +Add|

To add media, click |+dd! on the media tab.

After you select the file from the Select Files window and click the Open button, the media file will be
registered in the library as shown below.

In addition to photos, the same process can be used to register videos, Flash files, music, PDFs, and MS Office
files.

r—A Attention

e Please note that when a media file is deleted from the AutoUpload folder, it will also be removed from
the library.

— %4 Note

o Registered media files are automatically saved in the AutoUpload folder in the folder containing SuperSign
Manager. For example, C:\Program Files\SupersignMgr\AutoUpload.

o Once registered, a media file will be automatically logged in the library whenever SuperSign Manager is run.

o To change the library folder, click Options > Contents Edit in the file menu and select the Local media library
folder information field.

o By setting the Sync (Auto-upload) cycle in the Options > Contents Edit under the file menu, your library's media
files will be automatically uploaded at every designated time. To start the Auto-upload process, click Start Sync.
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Add Service Contents
You can use SuperSign Manager to add online content such as websites, RSS feeds, and widgets, as well as
their date and time.

1& Note

o Service contents cannot be saved together with media files in the library.
o For details on adding content, refer to the Create Content section of this manual.
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Creating Contents

Follow these steps to create contents:

Select Template or Layout

Select a layout or template to display various media on the screen. The example shows the layout set
to None. For specific information on how to change layout, refer to Changing layouts or Changing
Templates section of this manual.

Register Media in Library
YAl To use a media file, you first need to register it in the library. Register a media file as described in the
Using Library section of this manual.

i.
}m
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Display Media
You can exhibit media such as photos, videos, music, PDF, and MS Office files registered in the library.

There are two ways to display media on the canvas.

Add Media to Zone

Click the Zone button in the upper right of the screen.
Keep the Zone button on.

Move the mouse onto the desired location within the
canvas and click.
The zone is created as shown here.

Drag and drop a media file already registered in the
library.

The media will be added to the zone.
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Drag Media

You can directly display media files.

lg Photo ‘h! Photo090923_000.jpg ]
[ p—

;m

|

To do this, drag and drop a registered media file.

The file will be displayed on the canvas as shown here. A
new zone is also automatically created. The size and
location of the new zone can be adjusted.
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Display Service Content
LB You can use SuperSign Manager to add online content such as websites, RSS feeds, and widgets, as
well as their date and time.

To add service content, click Library > Service on the media window.

Add Websites

Library

. Media +Add Service

To add a website, enter the URL you want to add and click
Add.

http:/ fwww.lg.com

Clear Add

The website zone will be added on the canvas.

Move the new website zone to the desired location. Click
Preview in the quick menus. You will see the website
added as shown here.
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Add RSS Feeds

RSS

To add an RSS feed, enter the URL you want and click
RSS Feed

Add.

http://blog.lg.com/rss

Clear Add

The RSS feed zone will be added on the
canvas.

Qg Note

o The service and text zones can include one item each.

o RSS (Really Simple Syndication) is used to publish frequently updated works. Using RSS reader software,
users can subscribe to receive regularly updated content provided by their favorite sites in an RSS-
compatible format.

Display the RSS feed zone on the desired location
on the canvas. Click Preview from the quick menus
to see the screen with RSS content added.
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Add Widgets

To add widgets, enter a widget code and then click Add. Widget
Code

<script src="http:/ fwid

Clear Add

The widget zone will be added on the canvas.

PR w— = = |
[®] widget &2 o <script sre="http://}]

'\§ Note

o Widgets are small icons linked to frequently used services that users can run without opening a web
browser.

Display the RSS feed zone on the desired location on the
canvas. Click Preview from the quick menus to see the
screen with RSS content added.
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Add Dates
To add dates, click Add Date in the Date/
j
Time zone. o

The date zone will be added.

Display the RSS feed zone on the desired
location on the canvas. Click Preview in the
quick menus to see the screen with the added
time information.
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Add Times

To add times, click Add Time in the Date/
Time zone.

A time zone will be added.

Move the new time zone to your desired
location. Click Preview in the quick menus to
see the screen with the added time information.

DateTime

Add Date

Add Time

e %  mosse
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Copy Zones

A zone on the canvas can be copied and pasted to other spaces.

To do this, first select the zone you want to copy.

Click Edit > Copy in the file menu, or press Ctrl + C to copy the selected zone.

Click Edit > Paste in the file menu, or press Ctrl + V to paste the selected zone onto the canvas.

& Ta]BL5_lologo_02.jpg )

s

R

|

'\§ Note
(- If you copy a zone, its properties and the media in it will be copied as well.
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Setting Timeline

The timeline allows you to set the duration for each content clip so that your media can be played at the
designated time. On the timeline, you can set the start time, duration, and end time of the content in the zone.
You can set content to play for up to 12 hours.

Overview Timeline Setting

Timeline

Photo090923_000.jpg
L% Iglogo_02.jpg

hittp:/fwww lge.com

hittp://blog.|ge cormirss

(00:01:00] ~ 8 |7
k- You can display or hide the boundary color and file name of the zone on the canvas.
(On: & | Off: % )
4/ 1m' [»|  Set the basic time unit of the timeline. Time units that can be selected are 1 minute, 10
minutes, or 30 minutes.
o et Double-click on the zone name to change it. Click on the square in front of the zone name
o to change the zone's boundary color.
& You can enable or disable the repeat function. A zone with this feature on will be played
repeatedly until the registered end time.
(On: &2, Off: 2Z)
i) Lock the zone. Locked zones cannot be selected or edited.
(On: (5), Off: 75)
3 Delete the selected zone. To do this, select the zone you want to remove and click
3 or move the zone to the £} icon. You can delete the media within the zone using the
same methods.
00:01:17 This shows the total duration of the content. This time indicates the longest duration time

of the zones.

I background

Change the canvas background color or image. Click the square in front of the canvas name
to change its background color. To change the background image, drag a photo from the
library and drop it into the canvas timeline. Only one background image can be used at a
time.
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Add Media to Timeline
To add media to the timeline, drag a file to the timeline
of the zone you want to add.

Copy Media to Timeline

Select a media file from the timeline.

With the desired media file selected, press Ctrl + C.

Press Ctrl + V to paste the file.

Q?ﬁ; Note
(-You cannot copy text or services, including RSS, websites, and widgets.
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Distributing Completed Content

You can distribute content by sending it from SuperSign Manager to SuperSign Player in order to play it there.
There are three ways to distribute your content:

Immediate Distribution
Instantly send created content to SuperSign Player and play it immediately.

Please select a group or player. x

1 Select Player in the media window. The SuperSign Players
currently connected will be listed.

Select the SuperSign Player to which you want to transfer
your content.

Click Send to Player in the quick menus. The SuperSign
3 Send to Player window will appear. o< e

If there is no connected player, the Please Select a Group or
Player window will be shown for the player search.

nd to player

Enter the duration in the SuperSign Send to Player window and
click OK.

o Constant Repeat : Playing continuously until a new schedule is
added.
o Duration : Continue to play at this time for the duration.

Once the content is sent to SuperSign Player, it will be played on the connected screen.

Q\ Note
o When you transfer content via Send to Player, the schedules previously sent will be overwritten.
o With Send to Player, the content will be sent to player groups, not to an individual player.
o If the "The storage capacity is full." message appears, please check the free space available in the
management menu of SuperSign Manager. 69
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Scheduled Distribution
You can send content to SuperSign Player at the scheduled time. The content will be sent and played at the
designated time. For details on the scheduled distribution, go to the Schedule section of this document.

Export Contents

You can save content as a file format playable with SuperSign Player. The saved content can be moved via a
removable disk to be played on SuperSign Player.

The steps for exporting content are described below:

Complete the content and click Export contents.

Specify the folder in which the content will be saved.

Click Export Contents to create a new folder in which to save the content.

e The content's media and information files will be stored in the folder.

e Use a USB storage device to play the content file sent as Export Contents.

o Export Contents can be automatically or manually played in SuperSign Player.

— A\ Attention
e Export Contents is not available for images provided with the templates.

— '\§ Note
e Content that is saved in a USB storage device through Export Contents can automatically be played in
SuperSign Player as follows, depending on how the content was saved.
1. Create a folder named "AutoPlay" in the USB device.
2. Copy the cts and media files created by the Export Contents function to that "AutoPlay" folder.
3. When the USB device is inserted into the NC1000/NC2000 USB port, the content will play automatically.
4. When you remove the USB device from the port, the playback will be closed.
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Content Properties/Tool

In SuperSign Manager, users can check and modify the properties of the selected content.

Selecting a Canvas zone displays the zone properties in the upper right of the Properties window. You also can
change the time, image size, play repeat, and volume of the zone in the Tool window below the properties window.
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Content Properties / Tools
= Media File

Player

Name: 00:11:0F:00:08:68
Type: Landscape
Resolution: 1360 x 768

Background
Size: 1360x768

Shows information on
== the connected players
and groups.

== Background resolution.

Background v

Background color: N/
Background image:

=

8

Background customization
== Pictures only in the media
library can be used as

background.

<Background>

Property
Player
Name: 00:11:0F:00:08:68

Shows information on
TypesLandscapo == the connected players
Resolution: 1360 x 768
B and groups.

Name: Photo090923_000.jpg . .
== Shows information about

Dimension: 2048 x 1536

Slzes745Ke the selected picture.
Time S .
Duration 0 | o 2 Sets a playback time for
e e S e i
serting st 0 [S1:0 [0 [21 the selected picture.
Endingat 0 (311 (2130 (2
Fitting hd

Fit to zone as original.

Transition effects =

Fit to zone as full screen.

Unroll from top

Slide in from left

Fade

Expand out from center

Reveal out from middle

Adds special effects to
the picture.

Random squares appear

More effects -

<Photo >

original Fittazane rulzane | Fit t0 ZONe, keeping ratio.

Player

Name: 00:11:0F:00:08:68
Type: Landscape
Resolution: 1360 x 768

Shows information on
- the connected players
and groups.
Zone
Name: Zone
Size: 600 x 600
X: 156 Y: 68
Time: 00:00:00
Zone v

&) x| 600 (=

“= Zone infomation.

size: 600 “= Zone customization.
|_| Full canvas

Position X: 156 |
Yiles =

Background color: [N
Transparency: Changes zone order
& (bring to front, bring

" o= forward, send backward,

send to back).

Zone order
" B B =

Repeat zone

|¥] Repeat within canvas

«= Repeat setting within

canvas.
<Zone>
| Property | B .
p, Shows information on
Rone == the connected players
and groups.
Video

Name: MOVIE.avi
Dimension: 688 x 464
Size: 701MB

Time: 01:32:08

Time

== Shows information about
the selected video.

2= Sets the playback time.

Duration 1

Starting at 0

32
i0
32

[ [y

Ending at 1
Fitting

H N

Original  Fitto zone  Full zone

s Fit to zone as original.
== Fit to zone, keeping ratio.

Fit to zone as full screen.

Play v

V] Repeat playing Specifies whether to repeat

- \the playback of the selected
video within the set media

playback time.

Yolume
Yolume:
Q= ——

== \/olume control.
<Video>
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:l::" Shows information on :"“’"UU — Shows information on
-— lame: +11:0F:00:08:
the connected players N == the connected players
and groups. Resolution: 1360 768 and groups.
Music Flash
N.ame: MUSICmes . . Name: SuperSign.swf
f_‘m 9::1503 = <= Shows information about Dimension: 756 x 399 = Shows information about
ime: H H .
the selected audio. Shage 97K0 the selected Flash file
Time: 00:01:00 :
-
Time - ,
T, i o, [ ) Time - == Sets Flash file playback
puration 0 (=l 3 I51%%4 [xle= Sets an audio BORE o = | i time
Startingat 0 230 (2:0 (= . | .
rostt ~f1 =8 = playback time. Startng at 0 |20 12 ]
Endingat 0 [T :3 [$:54 (5 _: _T :
. Endingat 0 51 Sf =
':" = Specifies whether to e ‘ 2
Repeat playin -— .
ul ol repeat the playback of e == Specifies whether to repeat
Yolume % o
i the selected audio. the playback of the Flash
L ——r—r file..
== \/olume control.
<Music> <Flash>
Player: | Shows information on
:ame: 00:11:0F:00:08:68 - the connected players
'ype: Landscape
Resolution: 1360 x 768 and groups.
PowerPoint
: S Sign,, . .
vk == Shows information about
the selected document.
Time

‘o [2/== Sets an PDF playback time.

Duration 0
Starting at 0

ot
3]

Endingat 0 |5

<PDF/Office>

73



74

SuperSign Manager

m Service

Player

Name: 00:11:0F:00:08:68
Type: Landscape
Resolution: 1360 x 768
Web

URL: http://www.lg.com

Shows information on
== the connected players
and groups.

= Web site to be linked.

Tools

Time
Duration 0 '3

Sets the playback time for

== the selected web site.
Starting at 0

Ending at 0 5
web
*URL

«= Changes the web site to
be linked.

http://www lg.com

Change

<Web site>

Player

Name: 00:11:0F:00:08:68 -—

Type: Landscape players and groups.
Resolution: 1360 x 768

RSS |

URL: http://blog.lg.com/rss.

feeds to be linked.
| Toors |

Time

Duration 0 |51z

Starting at 0

Player |
Name: SuperSign
Type: Landscape

Shows information on
«= the connected players

Resolution: 1360 x 768 and groups.
Text \
Time =2

Duration 0 |5 3
Starting at 0|2 == Sets a text playback time.
Endingat 0 (o]*1 (2120 |2
Text
Font:
size: T

- == Sets the text format to the
selected style.

Color: I
Style:
alignment:

Line space:

Spacing: E
Text scroll -
Text scroll:

28] 181) (8L

== Sets the direction and
speed of the text movement.

20
Speed:

<Text>

Shows information on the connected
. RSS (Really Simple Syndication)

:_ Sets the playback time for the

Ending at 0 [ selected RSS feed.
Text
:m: # ~ Sets the text format to
Color: | " the selected style.
Style: A A A
Text scroll 5
T e e ) (a1 __ Sets the direction and speed of the
Spec T text movement.
I ——iL
B T Changes the RSS feed to be linked.
http://blog.lg.com/rss
hange
Title space: ,z.i - . Sets space between RSS titles.
et R Sets RSS update period.
<RSS>
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Player |
Name: 00:11:0F:00:08:68
Type: Landscape
Resolution: 1360 x 768
Date

Shows information on

. and groups.

Time

Duration 0

Starting at 0 |
Ending at 0 |
Text
Font: | Arial

== Sets the text format to
the selected style.

Size: 28 ~
Color: | ]|
Style: A A

Date display

A

e «= Date format.
YYYY.MM.DD.Week
YYYY/MM/DD/Week
MM.DD.YYYY
MM/DDAYYY
MM.DD.YYYY. Week
MM/DD/YYYY/Week
DD.MM.YYYY

DD/MMAYYY

<Date>

Player ‘
Name: 00:11:0F:00:08:68

Type: Landscape

Resolution: 1360 x 768

Widget |
URL: http://www.lg.com

players and groups.

widget.

Tools

== the connected players

= Sets a date playback time.

. .
Player | Shows information on
Name: 00:11:0F:00:08:68

e iahdieee == the connected players
and groups.

Resolution: 1360 x 768
Time

Tools

Time

Duration 0

~ == Sets a playback time for the
time content.

Starting at 0 |
Ending at 0
Text
Font: Arial

" . Sets the text format to the
selected style.

Size: 28
Color: .
Style: A A A
Time display

*= Time format.

00:00:00
AM 00:00

00:00

<Time>

Shows information on the connected

4 Information about the connected

Tme "= Sets awidget playback time.

Duration 0 v :1 S50 |5
Startingatu_ﬁ:u_ﬁ:l:l_i}

Ending at 0_3"'1_;"0__%

Widget ¥

*Code - Changes the URL of a widget to
http://www.Ig.com be connected.

Change
<Widget>
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Schedule

A schedule is the time table for playing content in SuperSign Player.
Schedules are set as daily, weekly, or repeating.

Overview
Index Description
Information about the player connected to SuperSign Manager is displayed. The content and media

files created in the content editor are listed.

Display times are set by 10 minutes, 30 minutes, or one hour.

Assign content and media files to the desired times. You cannot set them to a date already past.
The schedule should be within 180 days after the present date.

Schedules are shown in three different modes.

The daily schedule (24-hour unit) is displayed.
e Today  Click the Today button of the daily mode to move to today's date.
Click the Today button of the weekly mode to display the present week.

The daily schedule (24-hour unit) is displayed.
o Daily Click the Today button of the daily mode to move to today's date.
Click the Weekly button of the daily mode to move to the selected dates.

The weekly schedule (7-day unit) is displayed.
Weekl Click the Today button of the weekly mode to display the present week.
(]
y Click the Daily button of the weekly mode to go to the selected date.

If no date is selected, it will go to the first day of the selected week.

Schedule properties are displayed.
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Properties and Tool Windows

Player

m_ Name: Playerl

Type: Landscape
Resolution: 1600 x 900

Canvas File

Name: DS.Content_201002...

s Resolution: 1600 x 900

Size: 1MB
Play time: 00:01:00

Starting at

Bz (22 2 25

s (3o 3o B am [~]
Ending at

zo10 (&> |5 [=

o Bo Bc B am [~

L Aall day

B Sirepea )

The name, type, and resolution of the selected player.

[3) Preview the selected content.

The properties of content or media files for which schedules are

registered.

[B) Enter the duration directly to display content.

Set a repeat cycle.

To set repeat cycles:

Repeat

oK Cancel

Enter the end time for the repeat.
Set the days for scheduling the repeat before the
Check the Every day box to repeat the play every

end date.
l day.

4 Click the OK button to update the schedule with
this change.
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Setting schedules

Fo

w

llow these steps to make a schedule:

Click the Player menu in the media window and
B select SuperSign Player on which to change
schedules.

The current schedules of SuperSign Player will be
displayed.

To change the schedule, select content or a media
file from the Library on the media window.

Create the basic schedule by dragging and
dropping the selected content or media files.

5 You can adjust the time by dragging a cell down, or
by entering its time directly in the properties.

24 Note

The schedule blocks can be adjusted up to 24 hours in increments of 10 minutes.
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Copying Schedules

Schedules can be copied in order to re-use them.

Select the schedule blocks you want to copy.

Press Ctrl + C to change the mouse pointer to the
I copy icon (R ). Press the Esc key to turn the icon
back to the mouse pointer.
Click the point on the schedule table where you
want to paste the copied schedule.

Click Save to apply the change.

79



SuperSign Manager

Deleting Schedules

Delete Schedules via File Menu

Select the schedule block you want to delete and then select Edit > Delete in the file menu.
Delete Schedules via X Button
Select the schedule block you want to delete and then click Delete.

Delete Schedules via Delete Key

Select the schedule block you want to delete and then press Delete on your keyboard.

Distributing Schedules

Immediate Distribution
Send the schedule to a selected player by clicking Send to Player.
Scheduled Distribution

You can set scheduled distribution times in Option > Distribution under the file menu.
The schedule distribution time is disabled by default.

Q\ Note

e You can stop the transfer while schedules or content is being sent. Once suspended, you should resume
the transfer process from the start. If the transfer is not 100% completed, the content will not be played.
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Management

The SuperSign Players connected to SuperSign Manager and the monitors connected to each player can be
managed by group in the management menu. By grouping distribution destinations, duration, and places to
be displayed, you can control player and monitor information.

Overview
Index Description

The SuperSign Players connected to SuperSign Manager are listed.

B Content and media files created from the content editor will be listed.

There is an. information tab containing tt.1e selec’fed St.JperSign PIayer,.and a control tab with
control settings. The player and control information will not be shown if you select a group.

*C@: Group, [ : Player, [ Display Device

(D} SuperSign Manager software items
Scan Research players.
Add Add a new group.
Delete Delete the selected group.
Tree view Tree view mode
List view  List view mode

Double-click the group or player to rename it.

3&; Note
". Group, player, and display names can be up to 20 characters each.

81



SuperSign Manager

— i& Note
e If a player is disconnected, it will automatically attempt to reconnect the SuperSign Manager.
o If SuperSign Manager becomes disconnected while in use, an alert message appear and status lights will

blink.

— '\& Note

o When more than one SuperSign Managers are used, you cannot use them to control the same player at
the same time. You should use the Manual Setting to connect the player to be controlled.

e When players are searched from more than one SuperSign Manager, the first player found will be

connected. The same player cannot be used by different managers.

Manage Functions

Distribute Content Immediately
Drag content or media files onto the management screen to distribute them immediately to the connected

SuperSign Player.

Select the content or media files to send to SuperSign
Player in the library.

Drag the file to the desired SuperSign Player.

The SuperSign Send to Player window will appear.

Enter the duration in the SuperSign Send to Player win-

dow and then click the OK button.

o Constant Repeat: Keep playing until a new schedule is added.
o Duration: Continue to play at this time for the duration.

Constant repeat

puration: FRIIE oSS ¢

Once the content is sent to SuperSign Player, it will be played on the screen connected to SuperSign Player.

1& Note

o When you distribute media by drag-and-drop, it will be applied to the player group, not to an individual

player.
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Manage Groups

You can manage the players in a group and their displays here. When you select a group, the group-based tabs
will be activated. With the group-based tabs, you can control the player power, display power, time, screen,
audio, video, and other general features.

Qj Note
{: The status information is not available in the group control.

Control Players

You can control players that are in a group or are individually connected.

When you select a player, the appropriate items will be shown on tabs for each player.
The player's power, tile production, general features, and updates can be controlled here.

1& Note

o Scan allows searching players that share the same network with SuperSign Manager.
e The information of the searched player includes the player and the display.
o The SuperSign Player's power (On/Off) can be controlled in the same network.
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Control Displays

You can control the display connected to the player. When you select the display, the settings with tabs will be
activated. The display power, time, screen, audio, video, tile adjustment, and other general features are available
here. Each tab will list the settings of the current display.

Qj Note

o The display control will be activated according to its entries or options.
e The display control shows the status information of the connected display.
o RS-232C commands through hyper terminals are not executed while SuperSign Player is in use.
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* This function is not supported for NC2000.

Creating Tile Mode

Execute the Display Search for Daisy Chain before configuring Tile Mode.

......
You can specify the number of rows and columns in
the Tile Mode with mouse clicks or drag and drop. The
— size of tile cannot exceed the maximum number of
%_ displays connected.
1
Click Next.
mmmmmm

1]

~ Click the button to move to the next step.

Layout for the display wall will  You can configure each display’s input.
be organized automatically

according to the tile size you

set above.

You can select a display to be used in organizing the Tile Mode.
The displays you select will be highlighted as shown above.

85



SuperSign Manager

* This function is not supported for NC2000.

A\ Attention

o If select input source after selecting one display,
the display sets its tile size as 1x1.

1]

‘ — You can choose the order of the displays using drag
e : = and drop.

Apply : Complete the settings for a tile mode.
Cancel : Cancel the settings you made.
" Reset : Reset the settings to the default configuration.

In the Preview/Apply tab, the tiled image can be previewed.

24 Note

e The number of tiles cannot exceed the number of connected monitors.
o To connect multiple monitors for tile mode, see the How to Install section of this manual.
e The control shows the status information of the connected display.
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* This function is not supported for NC2000.
Option

If you want to manually search for a display after
connecting the monitor with an RS-232C cable, select
the Player and select Control > Options > Display
search for Daisy Chain.

Click Search to find and add the display connected
with a Daisy Chain.

87



88

SuperSign Manager

Other Features

Update Now
You can remotely update the SuperSign Player software.
The player settings which the user entered will not change.

Click a connected player on the Grouping & Monitoring
window and select the update tab menu under the Control
menu.

Press Open to select the SuperSign Player update files
downloaded from the SuperSign homepage, www.lg.com.

Press Update Now to update the software of the selected
player. The player in a remote location will be restarted
automatically after the updating is completed.

At this time, the player will be disconnected from the manager
and then reconnected when the reboot is finished.
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Send Messages
You can load messages on the connected player screen for urgent announcements, notices, or emergencies.

-~ Message  pre

[ 1= o Joe Ay =]

AW Set the text properties such as font, size, and color.
Enter the message to send.
(08 Adjust the location of the text to send.

Set the playback time of the message. The default duration is 10 seconds.

=8 Complete the message and click Send to instantly deliver it to the player.

Qt; Note

o Message entry is available only in landscape mode.

o The message will not be saved.

o However, the message format such as font, size, and color can be saved. The format will be saved only if
you send the message, and will not be saved if you close the window without sending it.
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Create Log Report
You can see the log information of system and contents.

e Log information reflects up to the previous 180 days.
o The report will be updated with the latest information.
o Using Send Email, you can send the log report files (.csv) to an assigned e-mail address.
o Change the email settings in Option > Management.

e Use Send an email in the lower part of the log report window to transfer the log file to the administrator.

o 8o - o 8 e O e ey
[Ty Er—— Sovrty

sevse] - Sondan email |

24 Note
E Details on the SMTP email setting are provided in the Appendix section of this document.
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Appendix

Frequently Asked Questions (FAQS)

Question

Answer

The transfer stopped during
"Send to player" task.

o Check whether the media file is an officially supported type and try again.
The officially supported media types are available in the Files Supported
by SuperSign list.

The "Scan" shows no available
players.

o Check whether the SuperSign Player is on.

o Check whether the SuperSign Player is working properly.

o Check the SuperSign Player's network cable connection status.
o Check the SuperSign Player's network IP address status.

o Set the SuperSign Player's network IP manually.

There are no templates visible
in SuperSign Manager.

o When selecting a player, if you select a player's resolution not supported by
the template, the template will not be shown.

e The supported resolutions are 1360 x 768, 1920 x 1080, 768 x 1360, and
1080 x 1920.

The data saved in the SuperSign
Player's C drive were lost.

e SuperSign Player uses the Enhanced Write Filter (EWF) function for
data protection. With EWF on, data saved by users in the C drive are only
temporarily saved. These temporarily saved data will be deleted when
SuperSign Player is rebooted. If you do not want to use the EWF function,
go to the Player menu and disable EWF.

MS Office files do not open in
SuperSign Player.

o Check whether MS Office program is properly installed. With EWF enabled,
MS Office will not be correctly installed. Disable EWF and re-install MS
Office. We advise you to enable EWF after the installation is completed.

Content is not playable even
though the content | sent to the
player was registered in the
media library.

e The player will not play the new content received if another file is playing
on the same player. Stop the content currently playing and then repeat the
"Send to Player" process.

Letters of RSS, text, or messages
are not correctly displayed.

o Change the MS Windows language setting using Regional and Language
Options.
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Frequently Asked Questions (FAQS)

Question

Answer

| cannot see photos or PDFs.

e Check the current settings of Regional and Language Options in MS
Windows and change the file name to be consistent with the language, then
reregister the file in the library. For example, photos with a name in Korean
may not be seen when the language is set to English.

After changing the time on

the Windows-based machine
on which SuperSign Player is
installed, | found that it changed
back.

o First check whether EWF was disabled when you changed the time setting.

o If it was enabled, disable it and then try again.

e Also check for the time sync option by right-clicking the Windows taskbar
and opening the Date/Time dialog menu. With this option checked, the time
will regularly reset according to the timeline selected by the user. If you
do not want to use this function, select the Internet Time tab on the menu
screen and uncheck the "Automatically synchronize with an Internet time
server" item.

After | sent content while
SuperSign Player was playing a
video, the video was disrupted.

e This could be caused by the network status. Please retry the transfer
when no content is playing in the player.

I lost the administrator password
of SuperSign Manager.

e Once lost, the password cannot be restored. In that case, you will need
to initialize the administrator account.

o To initialize the administrator account, type "1234567890init" in the
password field.

Where can | get SuperSign Player
programs or their driver files?

e You can find SuperSign\SuperSign_Software\Application\SuperSign
Player or SuperSign\SuperSign_Software\System\SuperSign Driver on
the CD included with the NC1000/ NC2000.

A message reading "as the web
server is not operational, the
program will be terminated"
appeared.

e This means the web server was not properly installed when SuperSign
Manager was set up. Even if another web server is available, SuperSign
Manager may not work properly. If you have another web server already in
use, delete it, or check whether the 6080 port is being used.
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SuperSign Network Connecting Instructions

Connect Network via LAN

This is used when SuperSign Manager and SuperSign Player are on the same network.
o The same network means that they use the same gateway and subnet address in the IP communication settings.

o The SuperSign Manager's search feature can be used to find SuperSign Players on the same network.

e For a single connection, use a crossover cable so that communication is possible without the use of network
devices.

o Web pages, widgets, and RSS are not available on a closed network not connected to the Internet.

o With no DHCP server on the network, you need to select the IP addresses of SuperSign Manager and
SuperSign Player manually.

Single Connection

v

3 SuperSign Player
SuperSign Manager

Multiple Connections

N
SuperSign Manager

SuperSign Player

7 | ‘
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Connect Network via Internet

Use this method when the manager and player are not on the same network.
o SuperSign Manager cannot search for different SuperSign Players that do not share the same network.

o SuperSign Player can be connected to SuperSign Manager on a different network through the Manual
discovery mode.

o If SuperSign Manager is on a private network, the SuperSign Player will not be correctly connected.
o If the network is equipped with a firewall, the transfer function may not work properly.
o Web pages, widgets, and RSS are not available on a closed network not connected to the Internet.

o With no DHCP server on the network, you need to select the IP addresses of SuperSign Manager and
SuperSign Player manually.

Private Network Connection

v

SuperSign Manager

- SuperSign Player

-
e ——
-y

&/
< &
-

Internet Connection

v

SuperSign Manage.

SuperSign Player
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Wireless Network Connection

This is used when SuperSign Manager and SuperSign Player are connected via a wireless router.
o SuperSign Manager and SuperSign Player support both wired and wireless network connectivity.

e When both wired and wireless network types are used at the same time, SuperSign Player may not work
properly.

o Unplug the LAN cable if you want to connect the player to SuperSign Manager wirelessly.
Do not use wireless network devices when you connect to SuperSign Manager with the wired network.

o Check whether SuperSign Manager and SuperSign Player are on the same network when you use a wired or

wireless router. If they use different networks, the player search will not be available. If SuperSign Manager is
located behind the router or the firewall, the connection may not work properly.

Wired/Wireless Router

¥ L

-
i
=
- \

2 \

LY
\
\

5 SuperSign Player

-

SuperSign Manager

Wired/Wireless Complex Network

l ' - SuperSign Player

w EEREel a
S /@/‘é

SuperSign Manager

9



Appendix

Monitor Models Supported by SuperSign

# For NC1000, NC2000, supported displays are subject to change without notice for improvement of performance.

The range of features controlled by SuperSign Manager may vary depending on the monitors used with it. The
list below includes monitors that can be controlled by SuperSign Manager. Models not controlled by SuperSign
Manager are marked with an X.

Power Saving
Power Indicator

Monitor Model M3203C [ M3703C | M4213C | M4210L [ M4224C | M4224F
- NC1000 0 0 ) 0 @ 0
Compatibilty 155000 X X X X X X
Power (0] 0 (0} 0 (0] ()
Input Select (0] (0] (0] © (0] (0]
Aspect Ratio (0] (6] (0] ) (0] ()
Screen Mute (0] (6] (0} 0 (0} ()
Volume Mute (0] (6] (0] 0 ) 0
Volume Control (0] @ (0] ) (0] (0]
Remote Lock/ key Lock (0] (0] (0] ) (0] 0
Auto configuration O 0 (0] 0 8] 0
Tile Mode (6] 0 ) (o] [0) 0
Tile ID Set (6] (0] ) (o] 0 (]
Natural Mode (In Tilemode) (0] o (0} ) o ()
Function  |Picture mode(PSM) 0 0 () 0 0] 0
Sound mode ] (0] ] Gl () 6]
Fan Fault check ) (0] 0] 0 0o 0
Temperature value (0] (6] (0] 0 (0] (0]
Lamp fault check ) [0) ) & ) 0
Time (0] 0 (0] X o 0
Sleep Time (0] (0] (0] 0 (0] (0]
Auto Sleep 0] (4] ] 0 ] 0
Power On Delay o (6] (0] 0 (0] 0
DPM Select (o] [0) @] (o] (0] (o]
() [0) ) 0 (8] 0
6] (0] (] (o] ] 0
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Monitor Models Supported by SuperSign

% For NC1000, NC2000, supported displays are subject to change without notice for improvement of performance.

Monitor Model

M4715C

M5203C

M6503C

M3204C

M4214C

M4716C

Compatibilty

NC1000

NC2000

Function

Power

Input Select

Aspect Ratio

Screen Mute

Volume Mute

Volume Control

Remote Lock/ key Lock

Auto configuration

Tile Mode

Tile ID Set

Natural Mode (In Tilemode)

Picture mode(PSM)

Sound mode

Fan Fault check

Temperature value

Lamp fault check

Time

Sleep Time

Auto Sleep

Power On Delay

DPM Select

Power Saving

Power Indicator

le](e] e] (@] (e] (@] ] e] @] @] e] (e] o] e] e] ¢) e] (e] ¢] @] e] @] e] Fd e
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Appendix
SuperSign Manager Menu List

File Menu

Menu Enabled

Main menu Sub menu Option Conterts Edt]_Plan | Management Description
Write a new canvas (] Write a new canvas
Open [ Open exisiting contents file
Close ° Close currently editing canvas
Save ° ° Save currently editing contents
Save as [ Save contents to new name
File | save for Template ° Save contents as a template
Export contents o Export currently editing contents to the file
Send to player [ ° Send currently editing contents to the player
Log out Py Py ° User log out
Password Change ° ° ° Change user password
Exit ° ° ° Exit the program
Edit Menu
) Menu Enabled L
Main menu Sub menu Option Contents EQt| Plan | Management Description
Cut [ ] ° Cut
Copy ° ° Copy
Paste [ Paste
Delete [ ] Delete
Edit Move to Contents. o
Edit window Move to Contents Editing window
m‘l’;\f il ° Move to Plan window
Add group [ ] Create a new group
Release group ° Remove selected group
View Menu
Menu Enabled
Main menu | Sub menu Option = Description
Contents Edit | Plan Management
150% [ ] [ ] 150% (Zoom in)
120% [ [ 120% (Zoom in)
100% ° ° 100% (Original)
Zoom 80% [ [ 80% (Zoom out)
60% [] [ 60% (Zoom out)
50% [ [ 50% (Zoom out)
30% ° ° 30% (Zoom out)
Preview [ Preview currently editing contents
Show Wizard o ° [ ] Show Start Wizard when startup the program or write a new canvas
Hide Wizard ° ° ° Do not show Start Wizard when startup the program or write a new canvas
View Timeline [ Show/Hide Timeline
Player
SR Template (] Show/Hide player/Template/Library
Window Library
Property ° Show/Hide Property/Tool
Tool
p,layer ) Show/Hide player/Library
Plan Window orary
Property ° Show/Hide Property TimeSetting/Library
TimeSetting
Library (] Show/Hide Library
"\,Awa::fﬁmem Information ° Show/Hide Information/Control
Control
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Option Menu

Menu Enabled

Main menu Sub menu Option = Description
Contents Edit| Plan | Management
Start search [ ] (] (] Start Player Scanning
Contents Edit ° ° ° Set options related to Contents Edit mode
Option
Management ° [ ° Set the E-mail of the administrator to send the Logreport
Distribution [ ] [ ] ° Set contents distribution time schedule

Setting Menu

Menu Enabled

Main menu Sub menu Option Description
Contents Edit | Plan Management

Server (] [ ] (] Show server information

Setting
Reset ° ° ° Initialize the SuperSign Manager settings

Help Menu

Menu Enabled

Main menu Sub menu Option ConenisEdt| Plan | Management Description
Manual [ ] [ ] [ ] Show SuperSign manual
Help Technical Support [ ] [ ] [ ] Show LG Electronics technical support information
About ° ° ° Show SuperSign Manager software information
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Appendix
Required Software and Codec Package Installation

Required Software

You should install all software below in order to take advantage of all Edit functions in the SuperSign solution.

Microsoft Office
To create content with Microsoft Office Word, PowerPoint, and Excel documents, both SuperSign Manager and
SuperSign Player should have the same version of MS Office installed (e.g. 2000, XP, 2003, or 2007).

You should purchase and install Microsoft Office.

A\ Attention
g

Adobe Acrobat Reader (8.1 or later)
To see Help and to use PDF files as media, Adobe Acrobat Reader version 8.1 or later (excluding the Lite version)
is required. Adobe Acrobat Reader should be installed on both SuperSign Manager and SuperSign Player.

'\§ Note

e You can download Adobe Acrobat Reader from the installation CD, or from the Adobe website at
www.adobe.com for free.
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Codec Package Installation

You need to install codecs if you want to upload or play videos.
If SuperSign Manager and SuperSign Player have different codecs installed, the player may not be able to play
content. Use the same type and same version of codecs on SuperSign Manager and SuperSign Player.

You may need different codecs depending on the video files.

You can download codec packages from the links below.
o http://www.codecguide.com

o http://shark007.net

o http://www.free-codecs.com

r—A Attention Q Note
o Please check the site's instructions concerning the | | @ LG Electronics takes no responsibility for managing
codec license details. the above sites. Each site's content may change

without prior notice.

—4\ Attention
o Check if the package you downloaded has the required codec and install it.
o Install the same codec package in SuperSign Manager and SuperSign Player.
o Do not re-install the package if it is already installed.
o If you want to install another codec package, make sure that the one previously installed has been removed.

Files Supported by SuperSign

Supported Video File Formats: .avi, .wmv, .mp4, .mov, .mky, .ts, .tp, .mpg, .mpeg, .flv

A Attention
o To register and play videos, the SuperSign Manager and SuperSign Player should have the required codec
pack.

Supported Image File Formats: .jpg, .omp, .png.
A\ Attention

o The maximum image size is 8,192 pixels (width or height). The total number of pixels should not exceed
16,777,216.

Supported Audio File Formats: .mp3, .wma, .wav
Supported Flash File Formats: .swf
Supported Document File Formats: .ppt, .xls, .doc, .pdf
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Appendix
Limitations of Microsoft Windows Embedded Standard

The following are potential errors that may occur due to internal limitations of Microsoft Windows Embedded
Standard, which is the OS of SuperSign Player.

o If you press Alt + Enter on the DOS window, text other than English may be shown corrupted.

o If you use Save As function in the Print window, the menu window name will be displayed in English.

o When you move to sub-menu items such as Control Panel, some of the items, such as hyper terminal, country
and language setting, will be written in English.
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Swapping Displays

You can change the primary and secondary monitors in the Control Panel > Nvidia Control Panel.

I3 Set Up Multiple Displays

A\ Attention

o Nvidia Graphic Chipset which is the graphic card equipped in SuperSign Player (NC1000/NC2000) does not
support display swap in the Windows Display Registry Information.
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Appendix
SMTP E-mail Settings

Follow the steps below to set the SMTP e-mail. Log reports can be sent to the e-mail address you designate.

Select File menu Options > Management to use the e-mail setting menu.

View  Option  Setting  He
Start search

Contents Edit
Management.

Distribution

The Options window will appear.

Option x
Contents Edit

ok || cancel |

Type an e-mail address in the Administrator E-mail field to receive the report. Type the e-mail server
address in the SMTP Server field.

If the SMTP server requires user identification, provide the user ID and password and then click OK.
(Encryption such as SPA and SSL are not supported.)

When you have filled in the required fields, click Test E-mail.

n Check whether the test e-mail has arrived at the designated address.



@ LG

Make sure to read the Safety Precautions
before using the product.

Keep the Owner's Manual(CD) in an
accessible place for future reference.

The model and serial number of the SET is
located on the back and one side of the SET.
Record it below should you ever need service.

MODEL

SERIAL

Life's Good

WARNING - This is a class A product. In
a domestic environment this product may
cause radio inferference in which case the
user may be required to take adequate
measures.

Temporary noise is normal when powering
ON or OFF this device.
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